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Tom tat:

Ngay nay, da cé rat nhiéu cong cu va phan mém hd trg cho ngudi day soan bai
giang, thiét ké cac dang bai tap va kiém tra trong gidng day tiéng Anh & cac muc
dé khac nhau. Mot trong nhitng phan mém theo chuan E-Learning va dap ting yéu
cau clia ngudi day tiéng Anh la Hot Potatoes. Trong bai viét nay, tac gia mong mudn
gidi thiéu la phan mém Hot Potatoes nhu mot cong cu cong nghé thong tin hitu ich
trong viéc ho trg ngudi day thiét ké cac dang bai tap da dang, sinh déng; giup cho
hoc sinh, sinh vién trong viéc hoc va luyén tap cac ky nang tiéng Anh hiéu qua haon.
Cu thé bai viét sé gidi thiéu cac tinh nang hitu ich clia Hot Potatoes bao gém tao cac
bai tap dang cau hoi, bai tap dién vao cho tréng, tro chai 6 chir, bai tap dang sap xép
cac tlr /cum tu, bai tap dang sdp x€p cac cau tra 16i tuong iing véi cac cau hoi, va tinh
nang quan ly sé lugng I&n cac bai thi va cau hoi'.

Tir khéa: Hot Potatoes, phdn mém, thiét ké bai tap - bai kiém tra, chudn E-learning.
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Abstract:
Nowadays, there are many tools and software to support teachers to prepare
lessons, design exercises and tests in teaching English at different levels. One of
the software that follows E-learning standards and meets the requirements of
English teachers is Hot Potatoes. In this article, the author would like to introduce
Hot Potatoes software as a useful information technology tool in helping teachers
design diverse and vivid exercises, helping students, students in learning and
practicing English skills more effectively. Specifically, the article will introduce
useful features of Hot Potatoes including creating question-type exercises, fill-in-
the-blank exercises, crossword puzzles, words/phrases arrangement exercises,
exercises of sorting answers to the questions, and the ability to manage a large
number of tests and questions.”.
Keywords: Hot Potatoes, software, design exercises and tests, E-learning standards.

1. GiGi thiéu

Hot Potatoes la phan mém mién phi, dugc thiét ké do nhéom nghién ctu va
phat trién tai Dai hoc Nhan van va Trung tam Truyén théng Victoria va dugc xu
ly b&i Half-Baked Software Inc. Hot Potatoes da thanh phan mém mién phi ké
tl thang 10 nam 2009 va lan dau tién dugc phat hanh trong phién ban 2.0 vao
thang 9 nam 1998 tai hoi nghi Euro CALL & Leuven, vuong qudc Bi. Tai thai diém
nay, phan mém nay dang & phién ban 7.0.

Phan mém Hot Potatoes c6 ho trg multimedia va dap Gng kha day da vé cac
chuén vé E-Learning. Hot Potatoes hé trg viéc tao cac loai bai tap dién ti da
dang sau d6 c6 thé xuat thanh dang HTML hay cac Module dé dua Ién web thuc
hién viéc thi hay kiém tra qua mang theo kiéu Client-Server.

2. Cac chuic nang chinh cia Hot Potatoes.

+ JQuiz: Dung tao cac bai tap hé trg 4 loai cau héi“da lua chon”, “cau hoi tra 15i
ngan”, “cau héi hon hgp” va “cau hoi nhiéu cau tra 161"

+ JCloze: G6m cac bai tap dién vao chd tréng.

+ JCross: Thiét ké nhiing bai tap theo hinh thic tro choi 6 cht Crosswords.

+ Jmix: Module dung dé tao cac cau hodi sdp xép cac tir hodc cum tir dugc cho
ngau nhién thanh mét cau/doan hoan chinh theo yéu cau.

+ JMatch: Thiét ké nhiing bai tap gém cac cau héi dudi dang so khép hay sap
xép cac cau tra IGi tuong Ung vai cac cau hoi.

+ The Masher: Dung dé quan ly khi c6 s6 lugng 16n cac bai thi va cau hoi.
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3. Cai dat va dang ky st dung chuong trinh
3.1. Cai dat
Tai chuong trinh véi muc dich ca nhan mién phi tai dia chi http://hotpot.uvic.
ca/ v6i dung lugng khoang 8.5 MB.
Cai dat: click dup vao file
x

Select the language to use during the installation:

>
setup_hotpot_70 | 0K I Cancel |

30.exe

Hinh 1: Chon ngdn ng(f cai dat > Ok

Setup - HotPotatoes 7

- X
Welcome to the HotPotatoes 7
Setup Wizard
This will install HotPotatoes v 7.0.3.0 on your computer.
k is recommended that you close all other applications before
continuing.
Click Next to continue, or Cancel to exit Setup.
Cancel
Hinh 2: Chon Next
Setup - HotPotatoes 7 = X
License Agreement "
Please read the following important information before continuing. @

Please read the following License Agreement. You must accept the tems of this
agreement before continuing with the installation.

SOFTWARE LICENCE AGREEMENT A

By installing and using Hot Potatoes, you acknowledge that you have read and
understood these tems and condtions:

1. Distribution

The HOT POTATOES sutte is freeware. Copyright laws apply to both commercial

and freeware software, and the copyright holder retains all rights. You may distnbute
HOT POTATOES to other users free of charge, PROVIDING THAT YOU PASS

(ON THE WHOLE SUITE IN ITS ORIGINAL ARCHIVE FORM, DO NOTADDOR V¥

(@1 accept the agreement
(Ol do not accept the agreement

| <Back Ned> | | Cancel |

Hinh 3: Chon (I accept the agreement) > Next
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Setup - HotPotatoes 7

Select Destination Location
Where should HotPotatoes 7 be installed?

Setup will install HotPotatoes 7 into the following folder.

To continue, click Next. If you would like to select a difierent folder, click Browse.

| [[Bome.. |

A least 24.1 MB of free disk space is required.

| <Back [ Net> | [ concel

Hinh 4: Chon Next

Setup - HotPotatoes 7
Select Start Menu Folder
Where should Setup place the program’s shortcuts?

N

Setup will create the program’s shortcuts in the following Start Menu folder.

To continue. click Next. if you would ike to select a dfferent folder, click Browse.

lotPotatoes 7] Browse...

X

<Back || Net> | | Cancel

Hinh 5: Chon Next

Setup - HotPotatoes 7

Select Additional Tasks
Which addiional tasks should be performed?

Select the addtional tasks you would ike Setup to pedform while instaling HotPotatoes
7.then cick Next.

Addgional icons:
[ Create a dasitop icon
[] Crezte a Quick Launchicon

<Back [ MNet> | | Cancel |

Hinh 6: Chon Next
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Setup - HotPotatoes 7

Ready to Install
Setup is now ready to begin installing HotPotatoes 7 on your computer. /C\" /

Click Install to continue with the installation, or click Back if you want to review or
change any settings.

Destination location:

C:\Program Files (x86)\HotPotatoes7
Start Menu folder:

HotPotatoes 7

Additional tasks:
Addtional icons:
Create a desktop icon

[ <Back |[ sl | [ Concel |

Hinh 7: Chon Install > Finish

3.2.Pang ky st dung

TU giao dién bat ky cla phan mém Hot potatoes Click Help > Register

@jQuiz:fﬁ;ﬁﬂed] o : i

- [B]x]
File Edit Imsert Manage Ouestions Options Help
BB Y | vrBRE | BARKSE | B | 2 |
| Title ||
Q|1 jl | IMuItlp\e-chmce j
= Register & tings |
= pitings
Please enter your user name and registration key.
A Username.!
Kay'!
B I~ 1am a network administrator registering for all the users of this machine
o OK | X Cancel &, Getakey
A T Comet
c
I~ Cormrect
D

|Config: englishe.cfg

Hinh 8: Bang ky

Dung lénh Copy va Paste dé bao dam nhap dung User name va Key vao trang
Register. Danh dau chon vao dong “l am a network...” OK

Luu y: dé€ c6 User name va Key, ngudi st dung phai c6 email va dang ky qua
website http://hotpot@uvic.ca/reg/register.htm.

4. Khéi déng va cau hinh Hot Potatoes.
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4.1. Khéi dong Hot Potatoes

DE c6 thé st dung t6t phan mém nay, truéc hét can hiéu ré cac dinh dang cau
hoi da lua chon, cau hoi tra 16i ngan, cau hdi hdn hgp, cau héi nhiéu cau tra 1oi...
Tuong Ung véi mbi dang bai tap, chon chiic nang tuong Ung trén giao dién chuong
trinh dé thiét ké.

Half-Baked Software's Hot Potatoes - X
File Potatoes Opticns Help

Hot Potatoes- Version 7

From Half-Baked Software Inc

Hinh 9: Giao dién phan mém 7.0

4.2, Mét sé cau hinh can thiét chung cia Hot Potatoes

- TU giao dién tuong tac clia JQuiz (hay bat c tinh nang nao), vao Options >
chon Configure Output.

(i). Thé Title/Instructions: Sita ddi tiéu dé va gidgi thiéu clia dang bai tap khi
hién thi dang HTML (c6 thé sua lai tiéng Viét so véi dang mac dinh ban dau la
tiéng Anh).

(ii). Thé Prompts/Feedback: Viét hoa cac théong bao hién thi khi chon dung -
sai dap an, hay cac tiéu dé phu khac.

(iii). Thé Buttons: Viét hod cac nut cong cu khi thiét ké dang cau hdi ngan hay
cau hoi hén hop.

(iv). Thé Appearance: Diéu chinh giao dién trang HTML tuy bién.

(v). Thé Timer: Thiét lap gio cho bai tap xuat dang HTML.

(vi). Thé Other: Thiét lap cac thong s6 nhu: sé cau hai t6i da hién thi trén moi
trang HTML khi duogc tai, tron tha tu cac cau héi - cau tra |5i, xem diém sau khi tra
|6i dung, xem danh sach cac cau trd 1G6i dung.
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7 Configuration file: C:\Program Files\HotPotatoes6\english6.cfg
Undo Insert

it | PromptsiFesdback | Buttons | Appearance | Timer | Other | custom | el |

Exercise subtitle:
Quiz =]
7]
Instructions:
=]
(2
& Load | 3 save I &) save As I « OK | 2 Help |

Hinh 10. Cac tinh ndng tuong tac ctia Hot Potatoes

5. Soan thao cac dang bai tap tuong tac.

5.1.Jquiz

Chuic nang nay cho phép soan thao bai tap theo 4 ki€u cau hoi: Multiple-Choice
(cau cé nhiéu chon lua), Short answer (cau tra |6i ngan), Hybrid (cau hoi hén hop),
Multiple-select (cau héi nhiéu cau tra 16i).

- Nhdp chon chic nang Jquiz ti giao dién tuong tac.

-Trén clra s6 Jquiz ti€n hanh nhap cac dong: cau héi, bén lua chon cho déap an, va
dap an ding nhat.

- Chon kiéu cau Multiple Choice véi loai cau hdi trac nghiém mot hay nhiéu dap
an dung, cac dap an dung ta danh dau vao muc Correct.

The Cat Quiz

's more than that!

Hinh 11.Tinh ndang Multiple Choice véi loai cau hoi trac nghiém
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- Vao thuc don Manage Questions > Auto Response dé thiét ké cac thong bao
hién thi dung hoac sai cho dap an.

Bl

Fillin all blank responses to CORRECT answers with:

ICorrecl!

Fillin all blank responses to INCORRECT answers with:
[Sorry! Try again.

« 0K X Cancel ? Hep

Hinh 12.Tinh ndng Auto Response thiét ké cac thong bao hién thi cho dap an.

- Nhap nut cong cu Export to create HotPot7 web page (hay an F6) dé dong goi
cac cau hoi Jquiz vua soan thanh dang HTML tuong tac.

Sovens P

Save in: l 7] Desktop ~| « & o5 B
My Documents QGiao trinh )
A=) My Computer (CJHoi Thao KH A
(oK My Network Places QJoomla_l.5.7-Stable-Full_Package @
) Anh DHNN (CINew Folder

Bai thi tai chuc 2008 ((Jquan ly nha hang

Chuyen NGu D recovery
Kl | i

Filename:  [tenfi] |l|
Save astype: [HTML fles (*htm) & Concel |
Help l

Hinh 13. Xuat dir liéu ra dang HTML

- Nhap nut Save dé luu lai cac cau hoi da thiét ké (dang.jqz)

Huéng dan thém:

Thiét ké JQuiz theo ki€u Short answer (cau trd 15i ngan), Hybrid (cau hoi hén hop).
- Trén giao dién tuong tac JQuiz chon dang cau héi ngan hay cau héi hén hop.

- Soan cau héi va dap an (dang nay chi c6 1 dap an).

- Ddng gdi cac cau hoi bang Iénh Export.
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5.2. Jclose
Cung cép chiic ndng soan thao cau héi dang dién khuyét.

i5\HP6\tutorial\jcloze 1.jcl

This is a simple gap-fill exercise made with the JC/oze program. The user enters his or her
answers into the gaps, then presses the "Check" buifon to find out which are correct, and to
get a score. For each gap, any number of comrect znswers can be accepted. For example, this
|gap allows the answers “gap"”, "space”, "blank” and "slot". Try them and you'll see. If the user
needs help, he or she can c/ick on the "Hint" button to get a free letter. To get a free letter in a
particular gap, put the cursor in that gap before pressing the "Hint" button. The "Hint" button is
optional -- if you want to make the exercise difficult for your sfudents, you don't need to include
it. You can also include a special c/ve for each gap if you wish. Finally, you can make answer-
checking case-sensitive or not as you wish. This exercise is not case-sensitive -- you should

Hinh 14. Chic nang soan thao cau héi dang dién khuyét.

- Chon chuc nang Jclose tu giao dién tuong tac HotPot.

- Nhap tiéu dé va ndi dung cau hoi vao giao dién tuong tac.

- Boi den tur can duc 16.

- Nhap chon nut Gap.

- Nhap dap an cda ti duc 16 vao muc Alternative correct answers.

{ Gapped word altematives

Hinh vé 15: Chuc nang Jclose

- Nhap Ok dé dong y.
-Tiép tuc tién hanh tuong tu cho cac ti can duc 16 khac.
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& JCloze: [Untitied)
Ge ot et Cpiors bed

AeHBHOMY | L hd | BEWRSD | BE | ? |
Title I CAU HOI DIEN TU

Modn chinh dai the sau

Tioh gl bt ngd cing &

Sdu 809 Lax 4o oda Kong don ¢&i

A thini loan phung hod 88
C& 3au cdch baft Sdinci ghua [y

(Trn G2 minh Tri - thang 12-2007)

7 G I @ Qedere Gap I
B CearGoon I W Aute-Gawo I @ sShow Words I
Conlc: engiant.chy

Hinh 16: Cau héi sau khi thiét lap Gap

- Ti€n hanh dong go6i san pham thanh dang HTML nhu & phan JQuiz.

Hudéng dan thém: Vao Options > Configure Output dé diéu chinh moét s6
théng tin cadu hinh nham lam cho giao dién cau hoi truc quan va dé dang hon.

+ Thé Title/Construction: Viét hod tiéu dé va yéu cau clia cau hdi.

+ Thé Timer: Thai gian lam bai.

+ Thé Other:

- Chon Use dropdown list instead of textbox in output dé hién thi thém
hop thoai goi y cac dap an trong danh sach tha xuéng.

- Include word list this text: Hién thi cac tlr ggi y dién vao ché tréng phia
trén dé bai.

& Configuration file: C:\Program Files\HotPotatoes6\english6.cfg B = =] 5]
Undo Insert

Titlesllnstruclinnsl Prnmptleaedbackl Buttons l Appaarancel Timer  Other |Cuslom| CGl l

I~ Include SCORM 1.2 functions

V yse dropdown listinstead of text box in outpl_.[ﬂ

[V Include word list with text

I~ Make answer-checking case-sensitive
I” Include a keypad to help the studenttype non-roman characters

Always include these characters on the keypad:

IG ﬂ, letters is the minimum size for gap textboxes on the Webpage.

Jv Do special processing to handle right-to-left language data in the output.

I~ Create a separate linked file containing the JavaScript code

& Load | ) save | ) save as |  OK ? Help I

Hinh 17:Déng géi san pham thanh dang HTML
+ Nhap OK dé déng y.
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XY

5.3. Jmatch

La chdic nang giup tao ra cac kiéu cau hoi dang “ghép néi’, Jmatch cho phép xuat
két qua thanh hai dang bai tap kiéu ghép néi (kéo - tha) va bai tap dang chon lua két
qua dung nhat tur danh sach dua ra.

- Khéi dong chiic nang Jmatch tu giao dién tuong tac cia Hotspot 7.

- Lan lugt nhap vao néi dung cau hoi va cac dap an tuong tng.

| Start a Hot Potato

| Enter your data, questions,
answers, etc.

| Save your data.

| Set the correct configuration
| information.

{ Click on "File / Create Web
page”.

Hinh 18: Chuc nang tao cac kiéu cau hoi

Luu y: Nhap két qua ding tuong ling ngay sau cau hoi dé bai.

- Nhdp nuat cong cu Export this exercise to create a drag and drog Web page....
dé xuat thanh tap tin HTML dang bai tap kéo tha.

- Nhé&p nut cdng cu Export to create a HotPot7... dé xuat thanh dang bai tap chon
dap an dung tu danh sach ggiy.

5.4. Jmix

Giup tao ra bai tap dang ghép tu/cau thanh cau/doan van hoan chinh; day la dang
bai tap rat thudng hay gap trong mon Tiéng Anh.

- Khéi dong JMix ti giao dién tuong tac ctia HotsPot 7.

-Tién hanh nhap cac cum tir clia cdu vao muc Main sentence va dap an hoan chinh
vao muc Alternate sentences.
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Hot Potatoes is available for =]
Macmtosh and Windows.

Hinh 19: Tao bai tap dang ghép tu/cau thanh cau/doan van hoan chinh.

- Nhap nuat cdng cu Export this exercise to create a drag and drog Web page.... dé
xuat thanh tap tin HTML dang bai tap kéo tha cum ti hoan chinh cau.

- Nhédp nut cédng cu Export to create a HotPot7... dé xuat thanh dang bai tap hoan
chinh cau bang cach nhap chuét tuan tu vao cac cum tir ma dé bai goi y.

Huéng dan thém:

- Giai bai tap bang cach kéo cac cum tur ggi y theo thir tu ding xép thanh mét hang
ngang dé hoan chinh cau, xong nhap Check dé kiém tra.

- Gidi bai tap bang cach nhap chudt vao cac cum tir gagi y theo thi tu ding dé xép
thanh moét cau hoan chinh & phia trén.

5.5. Jcross

HO trg viéc tao bai tap 6 chit kha nhanh chéng va dé dang.

- Khéi dong Jeross tu giao dién tuong tac cia HotsPot 7.

- Nhap tiéu dé clia cau hoi va cac ti khoa ctia 6 chir du dinh tao.

S6 04 N&m 2023




KHOA HOC. CONG NGHE

S D D Cross [m]
2 2
J M|l X
C
A JAVASCRI PT
Crossword Q 0
made with
JCross u J S w
| MAS HER
VA A B
T
J CIL OZ E
H

Hinh 20: Tao bai tap 6 chr.

- Nhap nut Add Clues dé nhap goi y cho cac tir khoa trong day 6 chir: gom c6
cac tu khda hang ngang va hang doc tuong ung.

J T
JAVASCRIPT The scripting language used to create these exerci
MASHER The program used to build linked sequences of exe...
JCLOZE The program used to make gap-fill exercises.

nak rd
Jauiz The program used to make exercises with short-an...

2
3 JMATCH The program used to make matching exercises.
4

WEB The Hot Potatoes progi make pages.

The program used to make this crossword. [
/" OK

Hinh 21: Cac budc tao bai tap 6 chr.

Luu y: Khéng dugc bo trong cac chi thich cho ti khoa, néu khong HotPot 7 sé
bao 16i trong qua trinh xuat thanh tap tin HTML.

- Nhdp nut cong cu Export to create a HotPot7... dé xuat cau hoi 6 chi thanh
dang bai tap tin HTML.

* Huéng dan thém: Khi giai 6 ch( ngudi dung nhap vao tir khod nao thi goi y
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tuong Ung cla tir hang ngang va hang doc sé xuat hién, Iic nay nhap dap an vao
khung tréng réi nhap nut ENTER. Sau khi hoan tat 6 cht nhap nut Check dé kiém
tra két qua danh gia.

5.6. Masher

La cong cu thiét ké trg gitp quan ly mét s luogng 16n cac bai tap dugc tao ra baoi
HotPot6, n6 bién dich tat ca cac loai bai tap dugc tao ra bdi cac Module riéng biét
thanh moét don vi: tao ra muc luc ¢6 lién két dé dé dang han trong viéc thao téc.

- Kh&i ddng Mashet tu giao dién tuong tac cia Hotspot 7.

- Nhap nut Add Files va dua vao tat ca cdc mau bai tap da dugc lam ra tu cac
Module riéng clia Hotspot 7 (thudng la cac tap tin c6 phan mé rong Ung véi cac
chuc nang & trén hay cac tap tin HTML).

- Nhdp OK to All dé dong y viéc dua vao tat ca.

o The Hot Potatoes Masher: [Untitled)
Be Af%ocs Cptons Hototatoespet beb
B ¥ BER ?

Fijos |mwm|vs«tw|w:|§wm[m|
Data e | Outpee fie n__ | Neot exarcise i name [ Outpettype |

&nﬂx Mm  index htm Pascal htm

@%Poscolhtm  PascalMtm  Pascalt htm <
¢ Pascalt tm Pascalt htm  thohem

[@§thotem  thohtm toan hem

@toanem 020 htm toant kem

toan1 em  tosnl hem cross hem

@§crossem  cross hem

Hinh 22:Thao tac véi Mashet
- Nhap nut Building unit... dé€ tién hanh xay dung trang chi muc lién két.

6. Cach chén hinh anh trong Hot Potatoes.
- TU clra s6 cda giao dién chuong trinh chon Insert > Picture > Picture from

File Local.
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Tit FHH HTML Table  CtriT
Wl Media Object

[T IMatch: C:\Documents and Settings\Administrator\Desktop\U3_C_before ‘p36\USIENE
File Edit | Insert Manage Items Options Help

o e I T s
Link. » B m L

=lolx|

LR

-Before you listen

Left (ordered) items H Right (jumbled) items

[ |

S 1 Nguyén Théy Hién | =] [wushu =
v =l E
Marion Jones ,3]|Alhletics 3_] r
Nellie Kim ﬂ Gymnastics ;I
=i |
ILy Birc =1 [Body building = |
= i
IE' Lance Armstrong ][ Cycling = -
I/ |
Default: |??? 3
[ |Config: englishé.cfg 4
=1ofx|

File Edt Insert Manageltems Options Help

AcHEOR®Y [~ s be | BEWS B | 2 |

| Titlepmy

C._| istenina - Refore voui listen

21|

Lookin: | 3 U3_C_before_p36

File name:

Files of type:  [Web graphics (*gf. *ipg, *png)
4
T

=« & ckE-

[Thuy Hien.pg

[ Il 0 K o g g K 0K 0
m

=T
?2?
Default: |

IConfig: englishé.cfg 4

Hinh 23&24: Cac budc chén anh
- Chon dudng dan dén file anh trong may tinh > Open
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Hinh 25: Cac budc chén anh

TAP CHi KHOA HOC & CONG NGHE - TRUGUNG BAI HOC XAY DUNG MIEN TAY
Journal of Science Technology & Engineering  Mien Tay Construction University

ISSN 2525-2615



SCIENCE, TECHNOLOGY- ENGINEERING

- Lua chon vi tri chén dnh (Picture alignment) va chinh kich thuéc > OK

7. Cach chén audio va video trong Hot Potatoes

- TU clra s6 cla giao dién chuong trinh chon Insert > Media Object.
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Media file:
Width: |100 Height: |30

& Browse... |

Player(s) to use: [
Add Windows Media Player ->
Add QuickTime Player->
Add RealPlayer ->
Add Flash Player ->

K Remove

IV Include a simple link

]

Link text: I

X Cancel

Hinh 26&27: Cac budc chén audio va video

- Chon Browse...tim dudng dan dén file video, audio trong may tinh

Select a media file

Lookin: [ 3 U3_C_t2_p37
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Z5)U3_C_t2_p37ppt.htm

Unit 3_People's Background_Listening.mp3

[

File name: IUnil 3_People’s Background_Listening.mp3
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Files of pe: | All files ()

|Open|

Cancel
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Hinh 28: Cac budc chén audio va video
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KHOA HOC -CONG NGHE

- Chon Open

5 [=[ |

Media file: |../U3_C_t2_p37/Unit 3_People L] > Browse...

Width: [100 Height: [30

Player(s) to use: [Windows Media Player 5
{___Add Windows Media Player-> 1
Add QuickTime Player -> v

Add RealPlayer ->

Add Flash Player ->

X Remove

Link text: ] fU3_C_t2_p37/Unit 3_People’s Background_Listening.r

¥ Include a simple link

9K I X cancel

Hinh 29: Cac budc chén audio va video

- Va chinh kich thuédc mac dinh la Width 100 va Height 30
- Chon Windows Medial Player > OK

8. Uu va nhugc diém khi sit dung phan mém Hot Potatoes

Phan mém nay dugc st dung dé thiét ké cac bai tap nén chii yéu dugc dung trong
phan luyén tap, bai tap vé nha. Bén canh d6, gido vién c6 thé sir dung dé tao ra cac
hoat dong tro chai nham cung cap cho hoc sinh vén tir hodc 6n tap.

8.1.Uu diém

- La phan mém mién phi, ho trg thiét ké cac hinh thic bai tap phong phu, soan thao
dugc nhiéu dang cau héi trdc nghiém, dugc phép chén hinh anh; Ho trg xu ly, tron
ngau nhién ngan hang cau hoi (ké ca ddo thu tu dap an); C6 thé soan thao bang tiéng
Viét (dung Unicode) va dugc phép in ra giay kém dap an (thong qua mot phan mém
g0 van ban Word).

- Cho phép gUi bai trac nghiém ctia minh |én trang HP dé hoc sinh c6 thé lam thit &
bat ky dau cé may tinh noi Internet.

8.2. Nhugc diém

Hot Potatoes khéng hé trg cac ky hiéu toan, ly, hdéa con cdc mén hoc khac c6 thé sur
dung rat tot va tién Igi. Tuy nhién, chiing ta c6 thé van dung dugc HP bang cach gé cac
cobng thurc, biéu thic...cta Toan, Ly, Héa vao Word réi “chup hinh” cac cong thuc, ky tu
dac biét d6 va dua vao bang duong “chén hinh anh’”.

9. Két luan vé ich loi ctia viéc st dung phan mém Hot Potatoes

Phan mém nay thich hgp st dung dé thiét ké cac bai tap nén chl yéu dugc dung
trong phan luyén tap, bai tap vé nha. Tuy nhién, gidng vién c6 thé sirdung dé tao ra cac
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hoat dong tro choi nham cung cap cho sinh vién vén ti vung hodc 6n tap.

Phan mém Hot Potatoes gilp giang vién tao ra dugc cac bai tap da dang, phong
phu, tich hgp dugc nhiéu yéu t6 nhu am thanh, hinh anh, tang thém tinh sinh déng
va phuc vu cho mét sé loai hinh cau hoi can hinh anh minh hoa, chén moét lién két téi
mot dia chi trang web, hay mot vi tri nao dé trong may tinh cuc bo, tiét kiém dugc rat
nhiéu thai gian. Bén canh do, gidng vién cé thé khdng ché thai gian tra |5i va cho diém
tuong ung.

Hot potatoes |a mot chuang trinh dé tao cac tng dung E-learning trén www, ho trg
viéc tao cac bai tap dién ti da dang sau do c6 thé xuat thanh dang HTML. Giao dién
tuong tac HTML mang tinh tuang tac cao.

Trong khuén khé bai viét nay, tac gia muén gidi thiéu phan mém Hot Potatoes dén
quy déng nghiép cé mot cong cu ho trg trong giang day tiéng Anh. Tac gia cling mudn
don nhan cacy kién phan hoi ctia ngudi st dung gitip mé réng cac tinh nang cdia phan
mém nay va nham déng goép bai viét nay dugc hoan chinh hon.

Tai liéu tham khao:
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